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1. - Introduction

The "Acute Oral Toxicity (Guideline 425) Statistical Program" (AOT425StatPgm)
is designed to be used with the acute oral toxicity testing procedure
presented in OECD GUIDELINE FOR THE TESTING OF CHEMICALS, Section 4: Health
Effects Test No. 425, Acute Oral Toxicity: Up-and-Down Procedure.  For
convenience purposes, we will refer to that document as OECD TG 425 Procedure. 
The AOT425StatPgm program performs the calculations required to complete the
test procedure.

The AOT425StatPgm program, a copy of this documentation, and a copy of the
testing guidelines can be found on the Internet at http://www.epa.gov/
oppfead1/harmonization.  Information on how to download the program and
documentation from the Internet can be found at that site, or by searching the
Internet for "AOT425S"  You will find a file named "AOT425Setup.exe" which is
downloaded before you follow the instructions in this manual.  The program can
also be obtained on disk from the OECD or by contacting USEPA at the below
address.  This document describes how to install the program, starting with
the "AOT425Setup.exe" or with two floppy disks, and how to use the program.

EPA and OECD are interested in improving the AOT425StatPgm program.  If you
have any problems with the program or suggestions for improvement, please send
a message by mail to AOT425 Coordinator, USEPA(7506C), 1200 Pennsylvania Ave.
NW, Washington DC 20460, or send an email to AOT425@epa.gov.  In addition,
user communications regarding problems may be submitted by commenting at the
“Comments or Questions?” link at http://www.epa.gov/pesticides/comments and
including the string “AOT425” in your message.  An entry will be added on the
page http://www.epa.gov/oppfead1/harmonization/ to highlight problems and
improvements that may have been identified.

2. - Installing the Program

In order to install and run AOT425StatPgm, you must have Windows 95 or higher
installed on your computer and a minimum of 5 megabytes of free hard disk
space.  The Regional Settings of the computer (found on the Regional Settings
Control Panel from the Start/Settings button) must be set for English(United
States) before and during program use.
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If you have installed a previous version of this program, uninstall the
previous version before installing this version.  To uninstall the program,
open up the control panel and double click on the "Add/Remove Programs" icon. 
Follow the instructions to remove the program.  You may be asked several
questions during the process of uninstalling an old version of the program. 
If asked, we recommend keeping shared files and ignoring any message similar
to "Can't delete AOT425StatPgm."

Installing the Program with Floppy Disks

Insert Disk #1 into the floppy drive on your computer.  Using your mouse
pointer, click on the "Start" button at the lower left corner of your Windows
desktop, then click on the "Run" option.  Type "A:\setup" in the text box, and
click the "Ok" button. Click the "OK" button to install the program files into
the C:\program files\AOT425StatPgm folder. Insert Disk #2 when requested by
the installer.  A shortcut will automatically be placed in the Start Menu for
easy launch of AOT425StatPgm.

Installing the Program Starting with AOT425Setup.exe 

The "AOT425Setup.exe" file from the Internet or a CD is a self-extracting
archive used to install the AOT425StatPgm on your computer.  There are two
steps to install the program.  First, run the "AOT425Setup.exe" program to put
the installation files into the "C:\Windows\Temp" directory.  Second, run the
"Setup.exe" file in the "C:\Windows\Temp" directory to install the program on
your computer.  

There are two ways to run the "AOT425Setup.exe" self-extraction program.  You
can use Windows Explorer to open the folder containing the downloaded file,
and then double-click "AOT425 Setup.exe" to run the self-extraction program. 
You may also click on the "Start" button in the lower left corner of your
Windows desktop, click on the "Run" option, and then type the full path of the
file location in the text box.   Click "OK" to begin the extraction.  You will
need to specify a folder for the installation files.  The default folder is
"C:\Windows\Temp."  Other locations can be used.

When you have extracted the files for the installation, there are two ways to
run the installation program, "Setup.exe".  You can use Windows Explorer to
open the folder containing the installation files, and then double-click
"Setup.exe" to run the installation program (This file will have a
modification date of 1/16/1997).  You may also click on the "Start" button in
the lower left corner of your Windows desktop, click on the "Run" option, and
then type the full path of the installation file location in the text box. The
files will be located in the C:\Windows\Temp directory unless another
directory was specified.  The Windows Installer should appear.  To begin the
installation process, click the large button in the installer window, as shown
below.
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You will be prompted for a location in which to install the program.  Select
"OK" to install the program to the default directory of "C:\Program
Files\AOT425StatPgm" or select another location.  Select "OK" again to
complete program installation.  A shortcut will automatically be placed in the
Start Menu for easy launch of AOT425StatPgm.

After running "Setup.exe" you can delete the installation files (in
C:\Windows\Temp or another selected directory).

3. - Overview of the OECD TG 425 Test Procedure

The purpose of the procedure is to test the short-term toxicity of compounds
to rodents.  There are two forms of the test, the limit test and main test. 
These tests are described below.  The objective of the testing is to obtain
information on the median lethal dose (LD50) for the test substance.  The
procedure is sequential; that is, whether to dose another animal depends on
the results of the previous test.  Users may enter test results for one
animal, save the data, and then return several days later and enter test
results for the next animal.  Once testing is complete, the program uses the
test results to calculate the estimated LD50.  The user must use another
program to store and manage the test data.  Only the information needed to
calculate the stopping criteria and the LD50 estimate are entered into the
AOT425StatPgm.  The AOT425StatPgm calculates: 1) the recommended dose for the
next animal, 2) when to stop dosing animals, and 3) statistical estimates of
the LD50 and its confidence interval.

Overview of Limit Test

The limit test generally is used in cases where information indicates the test
substance is likely to be nontoxic below regulatory limit doses.  Slightly
different test procedures are used for limit doses of 2000 mg/kg and 5000
mg/kg.  In both cases, the general procedure is to dose one animal at the
limit dose (i.e., 2000 mg/kg or 5000 mg/kg).  If the animal dies, the LD50 is
inferred to be less than the test dose, and the main test must be conducted to
determine the LD50.  If the animal survives, additional animals are dosed. 
The response of the additional animals will determine whether the LD50 is less
than or greater than the limit dose and if a main test must be conducted (see
paragraphs 22 - 30 of "OECD GUIDELINE FOR THE TESTING OF CHEMICALS, Section 4:
Health Effects Test No. 425, Acute Oral Toxicity: Up-and-Down Procedure" for a
complete description of the limit test).
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Overview of Main Test

The main test is performed when the chemical is expected to be toxic or when
little or no information about its toxicity is available.  Single animals are
dosed in sequence.  The first animal receives a dose one step below the best
(or assumed) estimate of the LD50.  If the animal survives, the second animal
receives a higher dose.  If the first animal dies, the second animal receives
a lower dose.  This sequence is repeated until one of three stopping criteria
is met.  After recording the long-term outcomes for the animals, typically
after 2 weeks, the LD50 estimate and confidence interval (CI) may be
calculated (see paragraphs 22 and 31 - 35 of " OECD GUIDELINE FOR THE TESTING
OF CHEMICALS, Section 4: Health Effects Test No. 425, Acute Oral Toxicity: Up-
and-Down Procedure " for a complete description of the main test).

4. - Running the Program

When the installation has finished, you can start the program by clicking the
"Start" button in the lower left corner of the screen, scrolling up to
"Programs," and then clicking on the "AOT425StatPgm" icon in the menu.

The program has two windows.  The first window, the Data Edit window, is used
primarily to enter and edit test data.  The Data Entry window also shows the
recommended dose for the next test, and, if appropriate, the estimated LD50. 
The second window, the Report window, shows the data, recommended dose,
estimated LD50, and confidence interval in a report form.  The report can be
saved as a text file or printed.

Using the Data Edit Window

Figure 1 shows the screen after opening the program.  In Figure 1 the
following parts of the Data Edit window are labeled in large bold/italic text:
the task bar, header area, data grid, and message box.
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Figure 1: Data Edit window

With the exception of the "Options" menu, the menus in the task bar act like
buttons.  If you click on a menu, the program immediately performs that action
without first displaying a list of menu items.  Unlike the other menus, the
Options menu has three menu items.

Throughout this document, menu commands and push-buttons on the task bar will
be referenced in [bracketed bold text].  This distinguishes actual commands
from regular text and minimizes confusion.  The menu items and the functions
are as follows:

• [New Test] Clears all entered information.  Information for a new test can
then be entered.

• [Load Data] loads previously saved test information from a file.
• [Save Data] saves the current test information to a file.
• [Get Report] displays a report of the current test in a Report window.  The

report contains the file name, the header information, the recommended dose
progression, the actual dose and outcomes, a summary of the long-term
results, and the estimated LD50.  If the recommended dosages are not
followed in the testing, the report will also contain a warning regarding
the methods used (see additional information in Section 9).
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• [Options] allows the user to set options for saving files, identifying the
smallest usable dose for testing, and qualifying the confidence intervals
for the LD50 estimate (see details in Section 7).

• [About AOT425StatPgm] provides information about the origin and date of
this program.

• [Exit] quits the program.

Below the task bar, you will find the header information.  The header
information describes the test being performed.  The information describing
the test is entered into the white boxes.  Each white box has text on a gray
background to the left of the box describing the information to be entered.

• "Text/Substance" is a description of the test or substance being tested.

• "Test Type" is the type of test being performed.  The test type is defined
using a drop-down menu to select one of two options, either "Main" or
"Limit."

• "Limit Dose" is the maximum dose that might be used.  The limit dose is
defined using a drop-down menu to select one of two options, either "2000"
or "5000."

• "LD50" is the best estimate of the LD50 before the test based on whatever
information is available.  If you have no information from which to
estimate the LD50, enter the word Default.

• "Sigma" is the best estimate of the standard deviation for the lethal dose,
in the log scale.  Unless you have good information about sigma, use the
default value of 0.5.

When performing a limit test, the "LD50" and "sigma" are not used and cannot
be changed.  When performing a main test, the "LD50" and "sigma" are used to
determine the recommended dose for each animal.

The "Data Grid" is located below the "Header Information."  As the testing
progresses, you will enter information for each animal into the columns.  The
data grid has the following six columns:

• "Test Seq" is the test sequence. Note, the test sequence column cannot be
changed.  

• "Animal ID" is a character or numeric ID that can be used to link the data
in the AOT425StatPgm to data for the same animal in other data files.  

The animal ID can be up to 40 characters long.  The AOT425StatPgm does not
use the animal ID in the calculations.  However, the ability to link the
data used in the analysis to other data files is important.  Therefore, the
program requires that the Animal ID column be filled in.

• "Dose (mg/kg)" is the actual dose of the tested substance that was
administered to the animal.  The actual dose may be different than the
recommended dose for the animal. 

The dose must be a positive number and can have up to 12 characters.

• "Short-term outcome" is the animal response within 48 hours (or the
selected survival interval).  Valid codes are O = lived, X = died.  (Note,
this is the letter "O," not "zero.")
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• "Long-term outcome" is the animal response at the end of a 14-day
observation period. Valid codes are O = lived, X = died.   

• "Program's data entry messages" has messages from the program to guide data
entry.

If the recommended dose for the next animal can be calculated, it will be
shown in a light blue box in the dose column below the information for the
last animal entered.  The recommended dose is rounded to 2 or 3 significant
figures.

You can move around the data grid using the tab key, enter key, and arrow
keys.  Text can be deleted from a grid cell using the backspace key.

Data for the first animal is entered into the first row.  Data for subsequent
animals are entered into successive rows until the testing stops.  Each row in
the data grid contains the information for one animal.  The information should
be entered in the order in which the animals are tested, as indicated by the
first column, "Test Sequence."  

The message box is located at the bottom of the screen.  It contains
instructions on how to use the program, instructions on when to stop testing,
and error messages.  If there are errors in the header information, a message
will appear in the message box.

When the program starts, or when starting to enter information for a new test
(See [New Test]), the Test Type is "Main" and the Limit Dose is "2000."  These
values must be changed when performing a limit test or if a limit dose of 5000
is to be used.  The "LD50" and "Sigma" boxes show the default values.  The
test description (Test/Substance) starts with the text "Enter test
description."  All of the header information should be reviewed and corrected
before entering data into the data grid.  

The program does not print the Data Edit window.  To print the data, either
get a report and print the report, or hit the buttons "Alt" and "Print Screen"
simultaneously to transfer a picture of the data edit window to the clipboard.
Then paste the picture into another program (such as a word processor) and
print from the other program.

Using the Report Window

Clicking on the [Get Report] text in the task bar in the Data Edit window
opens up the Report window.  Figure 2 below shows an example of a typical
Report window.  The topmost section of the window contains a task bar (labeled
in large bold/italic text), with the following commands:

• [New Test] - Exits the Report window, returns you to the Data Edit window
and clears current test data

• [Print Report] - Prints Report window to the selected default printer
• [Save Report] - Saves the Report window in a text file format
• [Edit Data] - Exits Report window and returns you to the Data Edit window
• [Exit] - Quits the program

If the report has not already been saved to a file, you will be prompted to
save the report when selecting [New Test], [Edit Data], and [Exit].

The following tips for printing may be helpful:
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• When clicking on [Print Report] the report text is sent immediately to the
default printer.  The program does not use a print dialog box or allow you
to cancel printing.

• To change the default printer or change printer options, select the START
menu’s Settings/Printers menu item.  A window will appear.  Select the
printer to use.  Then use the File menu in the Printers window to set the
printer as the default printer or to modify the printer settings (by
selecting "Properties").

• You may be able to facilitate reading the report into Microsoft by using
".doc" as the extension for the report file.

• You may be able to facilitate reading the report into WordPerfect by using
".wpd" as the extension for the report file.

• The mouse can be used to select text in the Report window.  The selected
text can be copied to the clipboard by holding the Control key down while
pressing the C key on the keyboard. Text copied to the clipboard can be
pasted into a word processing program and printed from there.

Figure 2: Report window
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Figure 3 shows the full text of a hypothetical Report window with different
sections of the report labeled.  The upper section of the Report window shows
the date/time, the filename, and the last time the file was modified.  The
header information follows the file information and includes the test
description, the test type, the limit dose, the assumed values for LD50 and
sigma, and the recommended dose progression.  The information from the Data
Grid is shown in the middle part of the Report window. This includes the
animal ID, the dose, the short-term result, and the long-term result.  The
animal data is followed by the dose recommendation, if any, and the stopping
criteria, if any.

If the sequence of doses and short-term outcomes are not consistent with the
OECD TG 425 procedure, one or more warnings may appear (see additional
information in Section 9).  If all of the long-term outcomes have been
entered, the bottom of the report summarizes the long-term outcomes and
provides the estimated LD50 along with the confidence interval for the LD50.
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AOT425statpgm (Version: 1.0) Test Results and Recommendations
Acute Oral Toxicity (OECD Test Guideline 425) Statistical Program

Date/Time: Monday, May 21, 2001, 9:52:33 AM
Data file name: Case 5 33a 3 dead.dat
Last modified: 5/16/2001 12:05:42 PM

Test/Substance: Example Data.
est type: Main Test
Limit dose (mg/kg): 2000
Assumed LD50  (mg/kg): Default
Assumed sigma (mg/kg): 1

Recommended dose progression: 2000, 175, 17.5, 1.75

DATA:

Test  Animal     Dose  Short-term  Long-term
Seq.      ID  (mg/kg)      Result     Result
____________________________________________
   1       1      175           O          O
   2       2     2000           X          X
   3       3      175           O          O
   4       4     2000           X          X
   5       5      175           O          O
   6       6     2000           O          O
   7       7     2000           X          X
   8       8      175           O          O
   9       9     2000           O          O
  10      10     2000           O          O
  11      11     2000           O          O
____________________________________________
(X = Died, O = Survived)

Dose Recommendation: The main test is complete.

WARNING:
The data may not be correct
A spacing between doses is not completely consistent with the 
assumed sigma

Stopping criteria met: 3 at Limit Dose. 

SUMMARY OF LONG-TERM RESULTS:

Dose       O     X     Total
______________________________________

175        4     0         4
2000       4     3         7

______________________________________
All Doses     8     3        11

Statistical Estimate based on long term outcomes:

Estimated LD50 = 2000 (The one dose with partial response).
95% PL Confidence interval is 797.7 to Greater than 20,000.

Figure 3: Example of Report window text with labels

DATA FILE
INFORMATION

HEADER
INFORMATION

TEST DATA
FROM DATA

WARNING
(IF APPLICABLE)

SUMMARY OF
TEST DATA BY

DOSE

STATISTICAL
ESTIMATE OF

LD50
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5. - Using the AOT425StatPgm for a Main Test

The following steps provide a brief overview of how the program may be used
for a main test.  Figure 7 at the end of this section illustrates the steps.

• Enter the test description.
• Select Main from the Test Type menu.
• Select the Limit Dose from the Limit Dose menu.
• For a main test, specify the assumed LD50 and sigma if values are known;

otherwise, use the default values.

Note that the first row of data grid contains the recommended dose for the
first animal.  

• Save the data (click on [Save Data], select an appropriate directory, enter
a file name (the default filename is work.dat or work_001.dat; we recommend
changing "work" to another more descriptive name).

The recommended dose for each animal in turn can be obtained from the data
grid or from the report.  The report, if printed or saved, provides
documentation of the recommended dose.

• Click [Get Report]

Figure 4: Report screen before entering data for the first animal
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[Save Report] (the default file name is the name of the data file followed by
the word "Report" with the extension ."txt")

• [Exit] the program.

After dosing the first animal and observing the short-term outcome:

• Start the program.
• Click [Load data] to load previously saved data (note the load file dialog

box starts from last used directory).
• Enter data for the first animal (note there may be messages in the right

column).  Enter the actual dose, which may not be the same as the
recommended dose.

• Note recommended dose for the second animal and get a report, if desired.
• [Save data].

Dose a second animal and observe …

• Start the program.
• [Load data].
• Enter the animal data.  

Continue dosing and entering data until the recommended next dose says "Stop
Dosing" (see Figure 5).

Figure 5: Data Edit window with "Stop Testing" message

• [Exit] the program.
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Observe animals for 14 days to obtain the long-term outcomes.

• Start the program.
• [Load data]
• Enter the longer-term outcomes (should be entered as they become available. 

Once several animals have been started, the entry of delayed deaths may
cause program running and report errors.  See pages 18 and 23.)

The program says test is complete and calculates the LD50 estimate and its
confidence interval for the LD50.

• [Get report].
• [Print Report].
• [Save Report].
• [Exit] the program.

Figure 6: Final report at the end of the main test

The upper section of the report window (not shown here) contains the test
description, header information, and sequence of doses (similar to those shown
in Figures 2 and 3), discussed previously.  The bottom section of the Report
window (shown here in Figure 6) contains the final dose recommendation
indicating that the test is complete, the stopping criteria, the summary of
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long-term results, the statistical estimate of LD50, and the 95% confidence
interval for the LD50.

Lab Input Window Report window

Dose and
observe one

animal

Dose and
observe one

animal

Dose and
observe one

animal

Observe
response for

14 days Enter long-
term
outcomes

Save
Report

Enter dose and
short-term
outcome

Enter dose
and short-term
outcome

Enter dose and
short-term
outcome

 LD50 = …

 Stop dosing
and observe

 Dose another
animal

 Dose another
animal

Figure 7: Example program use flow for a main test



15

6. - Using the Program for a Limit Test

To use the program for a limit test, select the Test Type "Limit" from the
drop down menu in the header.  If the limit test is to use a dose of 5000
mg/kg, select 5000 from the Limit Dose drop down menu.  Figure 8 shows how the
screen looks when starting a limit test at 2000 mg/kg.

Figure 8: Data Edit window at start of limit test

Notice that the data grid is much shorter for a limit test, and the text boxes
for LD50 and sigma are disabled.

The sequence of steps when using the program for a limit test is very similar
to the sequence for a main test described in the last section, with the
exception that the limit test uses, at most, 5 animals.

7. - Options Menu Details

Clicking on [Options] in the task bar allows the user to access three separate
sets of options for running the program.  

The first set of options, [File Saving] is shown in Figure 9.

Figure 9: File Saving Options Menu

When the [Sequential Data File Numbering] option is checked, the program will
automatically assign a sequential number to each saved file.  If data are
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loaded from a file and the file name ends in "_###.dat" (where ### stand for a
number between 1 and 999), the default name when saving the file will have the
same name with the number increased by 1.  If the data have not been saved
previously, the default file name will be "Work_001.dat."  

To set the sequential numbering option, click on [Options] in the task bar,
then drag the pointer first down to [File saving], and then to [Sequential
Data File Numbering.]  When you have selected this option, a checkmark will
appear next to [Sequential Data File Numbering] in the menu.  Selecting
[Sequential Data File Numbering] again will de-select the option and the check
mark will disappear.

For example, if the file named "Data_001.dat" is loaded, the default (or
prompted) file name when saving the next time will be Data_002.dat.  Each time
the file is saved the number will increase by one.  For sequential numbering
to work, the file name must include an underscore character (_) followed by a
number and have the extension .dat.  Thus, the number in the file name
"Data001.dat" would not be changed because there is no underscore character.

If you are about to save your data using a file name that already exists, the
following pop-up window will appear:

Clicking Yes causes the program to overwrite (or replace) the existing file.  

If the [Overwrite File Backup] menu option is checked, the program will make a
copy of the existing file before replacing it.  The name of the copy will be
"Backup of" followed by the name of the file.

For example, let's suppose you have loaded test data from a file called
"testdata.dat." You then record information from another animal and decide to
save the file under the same name, overwriting the previous version of the
file.  If you have checked the [Overwrite File Backup] option, the program
will automatically save the previous version of the file under the name
"Backup of testdata.dat."  

The second option in the [Options] menu is the [Smallest Usable Dose].  This
permits you to inform the program of practical limitations to your
experimental dosing.  When you click on the [Smallest Usable Dose] menu
option, you see the box shown below in Figure 10:
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Figure 10: Smallest Usable Dose dialog box

Enter the smallest usable dose (mg/kg) for the test substance and your
laboratory.  Before using this option, see the discussion of the Smallest
Usable Dose in Section 10.

The third option in the [Options] menu allows you to select the confidence
intervals to be calculated.  Figure 11 shows the menu box for selecting the
confidence intervals:

Figure 11: Confidence interval menu options

The 95% confidence interval will always be calculated, and the "95%" option
will always be checked in the menu. In addition to the "95%" confidence
interval, you may choose to calculate the "90%" and/or the "99%" confidence
intervals.  To do this, you would click on [Options] in the task bar, then
drag the pointer down to [Confidence Intervals], and then click on the
additional confidence interval you wish to create.  When you have selected an
additional confidence interval, a checkmark will appear next to the selected
confidence interval in the menu box, and the pull-down menu will close.  To
select all three intervals, the menu must be opened twice.  Clicking on a
selected confidence interval will de-select the confidence interval, and the
check mark will disappear.

8. - Recovering from Mistakes

The program creates two files that provide safeguards against data loss due to
mistakes and accidents.  Both files are saved in the application directory,
that  is, the directory in which the program is stored (usually "C:\Program
Files\AOT425StatPgm)."  
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If the power fails or the program otherwise quits abnormally, you will not be
able to save your data.  However, the next time you start the program, the
program may be able to recover data that was unsaved at the time the program
quit.  If so, the program will load the unsaved data.  When the program is
running, any unsaved data are saved in the file "Recovered Data.dat" about
once every minute.  This file is deleted when the program exits normally.

If you create a new file, or load and edit an existing file, and answer "No"
when asked if you want to save the data, the data are automatically saved to
the "Last Unsaved Data.dat" file.  This file only saves data from the last
time the data were not saved.  Older unsaved data will be lost.  If you decide
you do want the data, find the "Last Unsaved Data.dat" file in the application
directory, copy it to your chosen data directory, and rename the file.

9. - Warning Messages

For a main test, the program's recommended dose and stopping rules are based
on the short-term outcome.  However, the OECD TG 425 procedure has some
special cases where the dose sequence and stopping rules may be based on the
long-term outcome or other considerations.   The special cases occur when an
animal unexpectedly dies late in the study (see portions of Guideline
paragraphs 23, 28, and 35).  The program provides warnings that the
combination of the dose and short-term outcomes appears to be inconsistent
with the OECD TG 425 procedure.  Possible situations when warnings occur
include the following:

• In special cases where dosing is paused to observe the previously dosed
animals, the toxicologist may make decisions that are not consistent with
the program's automated recommendations based on the short-term outcomes
but that conform with good practice;

• Special circumstances may arise requiring an informed decision by the
toxicologist and that decision may not be consistent with the OECD TG 425
procedure or may cause the final data to diverge from OECD TG 425
procedure; or

• Errors may occur, such as errors in dosing or errors in recording the doses
and outcomes.

If the program presents a warning, we recommend that you review the data for
accuracy and review the program settings for suitability.  If there are no
data entry problems, it is important to document the doses used and be sure
your laboratory records are clear.

There is also one situation with late deaths that may not present a warning,
but the user should recognize the procedure as erroneous and the estimate may
be incorrect.  If dosing proceeds to include three animals at the limit dose,
but no deaths occur until after the first of these 3 is dosed, it may be that
no warning will appear.  Unless the estimate is below the limit dose, it
should be disregarded.

10. - Smallest Usable Dose

The OECD 425 program allows the user to specify a smallest usable dose.  The
smallest usable dose is the smallest dose of the test substance that the lab
can or will administer for the study.  NOTE: The OECD TG 425 procedure does
not discuss the smallest usable dose.  To strictly follow the OECD Guideline,
do not use this option.

The user can specify the smallest usable dose by selecting the [Smallest
Usable Dose] menu option on the [Options] menu in the Data Edit window.  
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If the smallest usable dose has not been specified and the user enters 1) a
dose below 2.0 mg/kg, or 2) a sequence of two doses below 5.0 mg/kg, a window
will pop up asking if there is a smallest usable dose for this test. 
Answering "Yes" takes the user to the window to define the smallest usable
dose.  The program will only ask once.  If you answer "No" to the question by
mistake, go to the Options menu to define the smallest usable dose.

When the smallest usable dose is defined, then:

• The recommended dose for the next test is never lower than the smallest
usable dose.

• If there are three consecutive deaths at the smallest usable dose, the
program will ask if testing should stop.

If the answer is "No," a similar message will appear after four animals
have died at the smallest usable dose, then five, etc. until the user
answers "Yes" or another stopping criterion is met.

• If at least one dose is below or close to the smallest usable dose, the
following warning will appear in the report:

At least one dose is close to the smallest usable dose. A smallest usable
dose is specified for this test. The OECD 425 procedure does not define or
discuss how to use the smallest usable dose.

11. - Preparing and Reading Data Files and Importing Data from Other Programs

The AOT425StatPgm program saves the data in a text file.  The default file
extension for the data file is .dat (see Section 6).  Any file extension can
be used as long as the file is a text file (i.e., in ASCII text formatting). 
The format of the data in the data file is described below.

The Title/Substance, Test Type, Limit Dose, assumed LD50 and assumed sigma
values are each entered on separate lines.  Each line begins with several
characters that describe what is on that line.  The string of characters that
define what is on a line is called the "tag" for the line.  The header
information can be in any order.  When the file is loaded, header information
that is not defined within the data file is set to the default value in the
program when the file is loaded.

Following the header lines, the animal testing data (Animal ID, Dose, Short-
term Outcome, and Long-term Outcome) are stored as comma-delimited text, with
one line for each animal.  That is, each animal's identification number, dose
level, short-term outcome, and long-term outcome are on a single line
separated by commas.  Lines with animal testing data must contain at least one
comma and not start with one of the tags.

The tags that are defined are listed below.  All tags end with the colon
character.

TITLE: for the Title/Substance description
TYPE: for the Test Type (either "Main" or "Limit")
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LIMIT: for the Limit Dose (either "2000" or "5000")
ALD50: for the assumed LD50
SIGMA: for the assumed sigma
LOWDOSE: for the smallest usable dose (if it has been defined)
LOWSTOP: for the answer to whether to stop after N successive deaths at the
smallest usable dose, N or Y and number of successive doses, 3 or higher
integer.  For example: LOWSTOP: N, 3
DEBUG: Sets a flag to provide the Log(LD50), Log of the 95% confidence bounds,
Slope, and maximum log likelihood in the report.

If the animal test data can be exported from another program as a comma
delimited ASCII text file, that file can be loaded into the AOT425StatPgm. 
The user can then add the header information and save the complete data file
ready for AOT425StatPgm use.  Alternatively, the header and animal test data
can be imported if the text file has the format used by the AOT425StatPgm
program.  

The following is an example of a data file.

TITLE: Annex 2 Table 5 example
TYPE: Main
LIMIT: 5000
SIGMA: 0.5
ALD50: Default
1,175,O,O
2,550,O,O
3,1750,X,X
4,550,O,O
5,1750,X,X
6,550,O,O
7,1750,O,O
8,5000,X,X
9,1750,X,X

12. - Technical Details 

This section provides details regarding the correspondence between the OECD TG
425 Guidelines and the calculations in the AOT415StatPgm program.  

Technical Details on the Implementation of the OECD TG 425 Guidelines

The following paragraphs describe how the OECD TG 425 procedures are
implemented in the AOT425StatPgm program.  The numbered paragraphs below
describe how the program implements the procedures in the corresponding
paragraph in the OECD TG 425 Guidelines.  The unnumbered paragraphs following
the numbered paragraphs describe how the program handles situations not
explicitly described in the OECD TG 425 Guidelines.

The OECD TG 425 Guidelines are not always explicit about 1) when and if to
drop doses from the dose progression, 2) how to handle actual doses that are
not equal from the recommended dose, and 3) whether the stopping criteria are
based on the short- or long-term outcomes.  In addition, the program 1)
provides warnings when the data are not consistent with the OECD TG 425
Guidelines and 2) allows specification of a Smallest Usable Dose.  The
implementation of these items is described below.

7. For the main test, the recommended starting dose is 175 mg/kg if the
LD50 is set to "Default."  The default sigma is 0.5, corresponding to
half-log units between recommended doses.  Sigma is used to calculate
the recommended dose progression.

13. For the main test, the "48-hour survival" pattern used to determine
whether and how to dose the next animal is the "Short-term Outcome" in
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the data grid.  The "Status of the animals at termination" is the "Long-
term Outcome" in the data grid.  Once a stopping criterion has been met
and the long-term outcomes for all animals are entered into the data
grid, the program will calculate the LD50.  The LD50 results are based
on the long-term outcome.  The LD50 is calculated using maximum
likelihood except as specified in paragraph 42(b).

The program calculates the LD50 if all long-term outcomes are entered,
even if no stopping criterion is met.  If no stopping criterion is met,
the LD50 is labeled as preliminary.  The LD50 estimate is displayed in
the message box on the Data Edit Window if data (including long-term
outcomes) for four or more animals are entered in the data grid.

The program assumes that the animals are observed for a total of 14 days
to obtain the long-term outcome (see paragraph 27).

23. For a limit test at 2000 mg/kg, the program recommends conducting the
main test if the short- or long-term outcome for the first animal is "X"
(a death).  The LD50 assessment is based on the long-term outcome.

If the first animal dies in the short- or long-term and data are entered
for additional animals, the program recommends conducting the main test
regardless of the outcomes for the additional animals.

The program recommends starting the main test using a dose of 175 mg/kg
(i.e., setting LD50 = "Default").  This dose recommendation is based on
paragraph 7.

24. If the pattern in the long-term outcome is one of those in paragraph 24,
and all animals are tested at 2000 mg/kg, the program says "The LD50 is
less than 2000 mg/kg" and recommends conducting the main test.

If the recorded doses are not exactly equal to the 2000 mg/kg, the
program says the LD50 is less than the maximum of the recorded doses.

The program recommends starting the main test using a dose of 175 mg/kg
(i.e., setting LD50 = "Default").  This dose recommendation is based on
paragraph 7.

25. If the pattern in the long-term outcome is one of those in paragraph 25,
and all animals are tested at 2000 mg/kg, the program says "The LD50 is
greater than 2000 mg/kg." 

If the recorded doses are not exactly equal to 2000 mg/kg, the program
says the LD50 is greater than the minimum of the recorded doses.

In some instances where deaths are delayed, a main test may achieve a
sequence of 3 consecutive animals at the limit dose.  In these cases, if
all animals show short-term survival, even after long-term outcomes are
entered the program may erroneously say “The LD50 is greater than 2000
mg/kg.”  This result is incorrect.

27. The program recommendations are based on the long-term outcomes if they
are entered; otherwise, they are based on the short-term outcomes.  For
a limit test at 5000 mg/kg, the program recommends conducting the main
test if the long-term outcome for the first animal is "X" (a death).  If
the long-term (or short-term) outcome for the first animal is "O"
(survival) and two more animals are tested and both have long-term (or
short-term) outcomes of "O," the program recommends "Stop dosing
animals."  If all three animals survive in the long-term, the program
says "The LD50 is greater than 5000 mg/kg."
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If the first animal dies in the short- or long-term observation and data
are entered for additional animals, the program recommends conducting
the main test regardless of the outcomes for the additional animals.

The program recommends starting the main test using a dose of 175 mg/kg
(i.e., setting LD50 = "Default").  This dose recommendation is based on
paragraph 7.

If the second or third animal dies after the short-term observation and
before the long-term observation, the recommendation "Stop dosing
animals" changes to "Continue testing" until either three animals
survive or three animals die in the long-term.  See paragraph 28.

28. Decisions about whether to dose another animal are based on the long-
term outcomes, if they are entered, otherwise on the short-term outcomes
(evaluated separately for each animal).  Thus, if either of the second
or third animal dies in either the short- or long-term observation, the
program will recommend testing an additional animal until either three
animals have survived or three have died in the long-term observation.

As the short- and long-term data are obtained and entered, a
recommendation to "Stop dosing animals" may change to a recommendation
to dose another animal.  Dosing continues until either three animals
have survived or three have died in the long term.

29. If the pattern in the long-term outcome is one of those in paragraph 29,
and all animals are tested at 5000 mg/kg, the program says "The LD50 is
less than 5000 mg/kg" and "A main test may be needed."

If the recorded doses are not exactly equal to the 5000 mg/kg, the
program says the LD50 is less than the maximum of the recorded doses.

30. If the pattern in the long-term outcome is one of those in paragraph 30,
and all animals are tested at 5000 mg/kg, the program says "The LD50 is
greater than 5000 mg/kg." 

If the recorded doses are not exactly equal to 5000 mg/kg, the program
says the LD50 is greater than the minimum of the recorded doses.

In some instances where deaths are delayed, a main test may achieve a
sequence of 3 consecutive animals at the limit dose.  In these cases, if
all animals show short-term survival, even after long-term outcomes are
entered the program may erroneously say “The LD50 is greater than 5000
mg/kg.”  This result is incorrect.

31. For a main test, the program's calculations are not affected if the time
interval for assessing the short-term outcome is different for different
animals.  Assessment (and entry into the program) of the short-term
outcome should be delayed until one is confident of the survival of the
previously dosed animal.

32. The assumed LD50 is the toxicologist's best estimate of the LD50.  The
recommended dose for the first animal is one step below the assumed
LD50, where a step is a factor of the antilog of the assumed sigma, and
sigma is the reciprocal of the estimated slope of the dose-response
curve.  The default sigma is 0.5, giving a default dose progression
factor of about 3.2.  If no estimate of the substance's lethality is
available, set the assumed LD50 to "Default" to get a recommended dose
for the first animal of 175 mg/kg.  Using the default values, the
program uses the dose progression shown in paragraph 32.

For the corresponding value of sigma, the program uses the dose
progressions shown in paragraph 32 and Annex 2.  To get the dose
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progressions in paragraph 32 and Annex 2, doses close to the limit dose
may be dropped from the progression.  The program drops from the dose
progression the dose below the limit dose if log10(limit dose/dose) <
Min(0.15, sigma/2).

33. Dosing continues until one of the three criteria in paragraph 33 is met
or until the fifteenth animal has been dosed.  The calculations for the
stopping criteria are based on the short-term outcomes.  For criteria
(b) and (c), a reversal occurs if any of the following are true: 1) a
death is followed by a survival at a lower dose, 2) a survival is
followed by a death at a higher dose, and 3) a death is followed by a
survival at a dose greater than or equal to the limit dose.

For evaluating the stopping criterion in paragraph 33(a), a dose is
considered to be equal to the limit dose if the dose is closer to the
limit dose than to other doses in the dose sequence.

Criterion 33(c) is implemented following the discussion and examples in
Annex 3.  

34. When any one of the stopping criteria have been meet and the long-term
outcomes (outcomes at test termination) have been entered, the program
calculates the LD50.

If the long-term outcomes are entered for all animals, the program will
calculate the LD50.  If the stopping criteria have not been met based on
the short-term outcomes, the LD50 estimate will be labeled as
preliminary.  The LD50 estimate is displayed in the message box on the
Data Edit window if data (including long-term outcomes) for four or more
animals are entered in the data grid.

40. For each dose, the AOT425StatPgm report shows the number of animals used
and the number showing signs of toxicity.  

41. The LD50 is calculated using maximum likelihood, when possible, except
in the exceptional cases described in paragraph 42.  The statistical
calculations find the combination of LD50 and slope that maximizes the
likelihood.

If the data do not have a positive dose-response relationship and
paragraph 42 does not apply, the program says, "The data do not show a
positive dose response relationship."  The OECD TG 425 procedure can
result in data with zero or negative dose response in rare circumstances
(such as 1) starting at a very low dose with a small sigma; if all
animals survive, dosing may not stop before reaching the limit dose, or
2) testing of doses near the limit dose when stopping criteria 33(c) is
met and the data show zero dose response). 

If deaths occur late in the observation period, the program may not
recognize that the dose-response relationship is not positive.  In such
cases, which can include progression to a limit dose, the toxicologist
is cautioned to review for plausibility any program statement regarding
the LD50 estimate.

42. The procedures used in special cases are listed below.

When more than one subparagraph within paragraph 42 applies, it is not
clear which to use.  The program assumes that paragraph 42(c) applies to
tests where the limit dose is the only dose with partial response,
regardless of the stopping criteria.  Paragraph 42(a) applies in other
cases where the stopping criterion is paragraph 33(a).
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42(a) If 1) testing stopped based on the criterion in paragraph 33(a) or after
dosing 15 animals, 2) the data do not show a positive dose-response
relationship, and 3) the upper bound dose (limit dose) ended testing,
then the LD50 is reported to be above the limit dose. 

Final dose is considered to be equal to the limit dose if the final dose
is closer to the limit dose than to the next lower dose in the dose
progression.

If the data show a positive dose-response relationship, the LD50 is
estimated using paragraph 42(c) or using maximum likelihood.

42(b) If all the dead animals have a lower dose than all surviving animals,
the reported confidence interval for the LD50 is the range from the
highest dose for all surviving animals to the lowest dose for all dead
animals.  The LD50 estimate is the value of the LD50 that maximizes the
likelihood when the slope is fixed at 1/assumed sigma.

The confidence interval in this case is not a profile likelihood
confidence interval and is labeled as "Approximate."  The same
confidence interval is reported regardless of the confidence level.

The LD50 estimate obtained by maximizing the likelihood with fixed slope
may not be within the reported confidence interval.  In this case, the
program provides the message: "Warning: The 95% confidence interval does
not include the estimated LD50. The results should be used with caution.
The assumptions used to estimate the LD50 and/or its confidence interval
may not be appropriate for the data."

42(c) If the surviving and dead animals have only one dose in common and all
other dead animals (if any) have a higher dose and all other live
animals  (if any) have lower doses, the reported LD50 is the common
dose.  

43. When maximum likelihood can be used to calculate the LD50, the
AOT425StatPgm program calculates the LD50 using maximum likelihood.  Use
of other programs is not needed.

44. Stopping rule 33(c) is calculated by the program.  Separate calculation,
possibly using a spreadsheet program, is not required.  If this stopping
criterion is met, the LD50 is calculated as described in paragraphs 41
and 42.

If this criterion is met, the program may not be able to calculate the
LD50 by maximum likelihood (see paragraphs 41 and 42).

45. The AOT425StatPgm program calculates confidence intervals for point
estimates of the LD50.  Except for data covered by paragraph 42(b),
confidence intervals are calculated using profile likelihood.

47. The upper bound on the profile likelihood confidence interval may be
infinite, meaning that an upper bound does not exist.  Upper confidence
bounds greater than 20,000 mg/kg or infinite bounds are reported as
"Greater than 20,000."  The lower bound can be very close to zero. 
Lower confidence bounds that are below 0.0001 are reported as zero.

48. The AOT425StatPgm program provides information, particularly the LD50
estimate, that can be incorporated into the test report.

The program does not routinely provide the maximum likelihood slope
estimate.  Any slope estimate obtained from the OECD TG 425 procedure is
not reliable. 
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Implementation of Warnings

The program provides warnings if the reported doses and outcomes are not
consistent with the recommended doses.  For calculating the warnings, for a
main test a dose is considered equal to the recommended dose if the dose is
closer to the recommended dose than to other doses in the dose progression. 
For the limit test, a dose is considered equal to the limit dose if it is
within a factor of 3.2 of the limit dose.

Implementation of the Smallest Usable Dose

The program allows the use of a smallest usable dose.  The implementation of
the smallest usable dose is discussed in Section 9.   If the smallest usable
dose has been defined, a dose is considered to be equal to the smallest usable
dose if that dose is closer to the smallest usable dose than other doses in
the dose sequence.  

In paragraph 33, a reversal occurs if a survival is followed by a death at a
dose less than or equal to the smallest usable dose.  In paragraph 42(a), if
1) testing stops based on three or more consecutive deaths at the smallest
usable dose and the user says to stop or at the fifteenth animal, 2) the data
do not show a positive dose response relationship, and 3) the smallest usable
dose ended testing, then the LD50 is reported to be less than the smallest
usable dose.

Program Constants and Limits

In general, the program will read in any ASCII test file, regardless of
whether the contents of the file are valid for performing the calculations. 
Limits on data entry include:

Any printable characters can be entered into the Test/substance, LD50,
and sigma boxes.

Any printable characters except the following characters can be entered
from the keyboard into the data grid: , ~ % & ( | { and }.

Any characters except a comma can be read from a data file into the data
grid.

When reading from a data file, any text for the test type that, when
converted to upper case is not 'MAIN' or 'LIMIT' will be ignored and the
default 'Main' will be used.

When reading from a data file, any text for the limit dose other than
'2000' or '5000' will be ignored and the default '2000' will be used.

Although there is no formal limit on the number of characters in the
Test/substance description, we recommend using fewer than 400 characters. 
Very long descriptions have produced problems on some computer-printer
combinations.

If the data read from a file is not consistent with the file format for a data
file, extra information is ignored.  The program warns the user if the data
files have data for more than 15 animals for a main test or 5 animals for a
limit test.

The data read from the data file or entered from the keyboard are displayed in
the data edit window.  If the data are not valid for the calculations, the
program will present messages in the right column or the lower message box. 
The user can edit the data in the Data Edit window.
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The following defines valid data for the calculations:

The number of characters in the test/substance description should be
less than 32,000.

An animal ID can have up to 40 characters.

A dose can be any number from 1e-308 to 1e308.

A short and long-term outcome must be lower or upper case "O" ("Oh" not
zero) and "X."  These values will be converted to upper case by the
program.

The LD50 must be a number between 0.0000000001 and 100000 or the word
"Default."

Sigma must be between .01 and 4.0.

Unless otherwise specified by the user, the calculations use 1e-300 as the
smallest usable dose.

When using sequential file numbering, the number must be between 000 and 999
inclusive.

The program will always provide the 95% confidence interval, if it can be
calculated.  The user can optionally select a 90%, 99%, or both a 90% and 99%
confidence interval.  Other confidence levels cannot be specified.

The likelihood and profile likelihood calculations use a Newton-Raphson
algorithm.  For calculating the LD50, the model uses slope and intercept
parameters.  For calculating the profile likelihood, the model uses the LD50
and slope parameters.  The starting values for the parameters cannot be
specified by the user.  When calculating the LD50 with a fixed slope, the
starting value for the LD50 is –Log10(dose for the last animal)/sigma.  For
all other cases, the starting value is zero.

When fitting a model, the likelihood is assumed to be converged if the
relative change in the log likelihood is less than 1e-8 from one iteration to
the next.  After the likelihood has converged, iterations continue until the
change in slope on the last iteration is less than half the change in the
previous iteration or less than 0.1% of the maximum slope estimate.  In no
case are more than 40 iterations performed to obtain the parameter estimates. 
If the likelihood does not converge in 40 iterations, a warning message is
presented.  The algorithm uses step halving to minimize the likelihood in rare
cases where the Newton-Raphson step does not reduce the likelihood.  In no
case are more than 40 step halvings performed.  In practice, the algorithm
generally converges quickly without requiring step halving.  As part of the
algorithm, the program converts Z values from a standard normal distribution
to probability (P) values.  The function used accepts Z values from –37 to 37. 
P for values below –37 is zero.  If a Z value is less than –37, it is replaced
by –37.  Similarly, if the Z value is greater than 37, it is replaced by 37. 
In effect this minimizes the influence of outliers, avoids taking the log of
zero, and allows convergence in rare cases.

The program calculates some simple statistics to determine if the profile
likelihood confidence bounds are infinite or finite.  For finite confidence
bounds, the program steps away from the LD50 estimate, calculating the profile
likelihood, until a bounded range is obtained that encloses the confidence
bound.  In the log dose scale, when stepping away from the LD50, the first
step has a length equal to the range of the data. Each successive step is
bigger than the last step by a factor of 2.  If the bounded region around the
confidence bound is not found after 40 such steps, the bound is reported as
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infinite.  The confidence bound is located by successive bisection (on the log
dose scale) of the bounded region.  Up to 40 bisections are performed.  The
confidence bound converges if the relative difference between the critical
likelihood for defining the confidence interval and the estimate is less than
1e-8 or if the length of the bounded interval is less than 0.0001 on the log10
scale.

The constants determining the convergence of the likelihood and the confidence
bounds cannot be changed by the user.

The recommended dose is rounded to somewhat more than two significant figures
unless the doses are closely spaced, in which case more significant figures
are used.

Internally the LD50 and the confidence bounds are stored as double precision
floating point numbers.  When these are presented in the report, values below
0.0001 are presented as zero, values above 20,000 are presented as "Greater
than 20,000."  Values are presented to at least three significant figures;
however, trailing zeroes beyond the decimal are dropped.

For a selected data file, more exact estimates of the LD50 and confidence
intervals can be obtained by editing from the data file and adding a line
starting with "DEBUG:.”  Using this file, the log of the LD50 and confidence
bounds will be shown at the bottom of the report.  Based on comparison of the
AOT425StatPgm output to other programs, the LD50 estimates from the debug
information should be good to at least six significant figures and the profile
likelihood confidence interval bounds should be good to at least four
significant figures.  

The AOT425StatPgm program fits the probit model and gets profile likelihood
confidence intervals for almost any data, regardless of whether the data
follow the OECD TG 425 procedure.  It may be necessary to edit the data file
by adding a line with "DEBUG:" to get the parameter estimates.


